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1. General Information 

The BioTester 6000 is a precision test instrument specifically designed for the measurement and 
analysis of planar anistropic materials. The system includes a compact biaxial test station and an 
integrated software interface to run and analyze test results.  The system is intended for indoor 
use only.  The BioTester 6000 is upgrade of the BioTester 6000 system (maximum force of 23N) 
and is particularly suited for testing small, biological samples but at a peak force of 200N. 

Environmental and Electrical Specifications 

Electrical Input 100-240VAC, 50-60Hz 

Current Rating 3 Amp 

Environmental Conditions Maximum Operating Temperature 25ºC 

0% - 95% Relative Humidity 

Installation Category Category II 

Pollution Degree Degree 2 

Maximum Altitude 2000m 

Data Connections 1 – USB 3.0 for camera/PC communication 

1 – USB for controller/PC communication 

System Assembly 

The BioTester 6000 unit requires some assembly. See Appendices A and C. 

Power Connections 

Connect power supply into properly grounded 100-240VAC power source to ensure safe 
operation. Ensure that the power cord is easily accessible at all times.  The use of an 
Uninterruptible Power Supply (UPS) is recommended to protect against data loss. 

The mains supply voltage fluctuations should not exceed 10% of the nominal supply voltage. 

Safety Warnings 

This equipment must be used in accordance with the procedures outlined in this manual to 
prevent injury and/or damage. 

System Alert 

The plastic covers must remain on this unit at all times to prevent injury and/or damage. 

This equipment must not be disassembled by the user or modified in any way. 

Approvals and Certification 

This product conforms to EN61010-1:2001 and EN61326-1. 
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Manual Operating Controls 

There are a few manual controls on the unit. The camera housing contains two adjustment knobs 
that are used for fine adjustment of the horizontal camera position, and the camera lens has 
focus, zoom, and iris rings which can be set by the user.  

 

BioTester 6000 Tip: Setting Camera Controls 

The camera housing knobs are used to ensure that the specimen is centered in the field 
of view. The iris is usually left 100% open; the brightness of the images is better 
adjusted by changing the camera gain and exposure in the software settings. 

 

There are two switches on the front of the unit, one for powering the controller and the LED 
lighting, and the second for powering the heating element.  

The front of the unit also contains a pull rod which is used to raise and lower the specimen stage 
and fluid chamber. This rod is spring-loaded so that the chamber can be held at any height. To 
raise or lower the stage, lift the rod and then pull or push. 

Software 

LabJoy software is included and is required to run the BioTester 6000.  2 x USB ports are 
required for data connections, with at least one of those ports being USB 3.0.  Windows 10 is 
required to run LabJoy. 

General Maintenance 

Clean the system as needed with mild soap and water or alcohol-based cleaning solutions. 

  

BioTester 6000 Tip: Removing the fluid chamber 

The fluid chamber can be removed by resetting (fully retracting) the actuators followed 
by carefully lifting and twisting the chamber. This is best accomplished when the 
chamber is emptied (The large syringe supplied works well to drain the fluid bath). 
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2. Testing Terminology 

The BioTester 6000 is designed to apply biaxial forces to tissue/material specimens (deforms by 
more than 1% in vivo) with an in-plane dimension of 3 - 20 mm. This includes biological material 
such as eye tissue, heart valves, pericardium, joint capsules, large blood vessels, scaffolds, and 
polymers.  Forces up to 200N can be exerted using suitable grips. 

Multiphase Test Cycles 

In order to properly characterize and test a specimen, it is often necessary to load it to different 
degrees and at different rates. There are three main reasons for doing this: 

Preconditioning - The goal of preconditioning is to restore a specimen to its physiological or 
in vivo state. During the process of specimen storage and preparation, a specimen may 
swell, dry out, have its material fibers realign, or its molecules reorganize. It may take multiple 
preconditioning cycles for a specimen to be restored to its natural state. 

Reproducing Physiological Conditions During Testing - By applying various loads and 
load rates, natural expansion and contraction of a specimen can be reproduced (for example, 
the pulse pressure in an organ). In as much as the physiological conditions can be recreated, 
the specimen can be tested in a more realistic state. 

Varying Test Conditions - Variable loads and rates allow you to create a variety of test 
profiles to best study your specimen. 
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Phases, Cycles, and Test Sequences 

As the following diagram demonstrates, each application and release of load on the specimen is 
called a test cycle. The same test cycle can be repeated multiple times to achieve a certain goal 
(preconditioning, physiological conditioning, or testing); this is called a test set. Finally, a test 
sequence is made up of multiple test sets.  

 

The above example describes the following: 

• The entire diagram presents a full test sequence.  

• Within that sequence, there are two test sets: the first set applies preconditioning to the 
specimen; the second set executes the actual test on the specimen.  

• Within the first set (preconditioning), two identical test cycles are implemented to bring 
the sample to a satisfactory in vivo state.  

• Finally, the second set (testing) is made up of three cycles.  
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Test Phases: The Smallest Unit of Testing 

The test phase is the smallest unit of the test specification. There are five phases within a cycle. 
Each phase serves a specific purpose: 

Preloading- Preloads are applied to bring a test 
to a well-defined starting point. Because the 
dimensions of a specimen may change as a 
result of a loading cycle (stretching of fibers, 
viscoelastic effects, plastic deformation, or 
localized material failure at the attachment 
points), the preload adjustment compensates for 
any of these changes in specimen geometry.  

Stretching - During the stretch phase, a 
deformation is applied to the specimen. The 
deformation can be specified either in terms of 
force applied or displacement achieved.  

Holding - The deformation can be held for a given duration. The duration for which it is 
held is dependent on the nature of the testing. 

Recovering - The recovery phase is the time during which the force being applied to 
the specimen is removed. The duration of the recovery time is configurable and 
dependent on the nature of the testing. 

Resting - Finally, the rest phase is the time between the end of one cycle and the 
beginning of the next. Some tests may specify a short recover time, while others may 
specify a longer time. The duration is configurable and dependent on the nature of the 
testing. 

Control Modes 

There are two control modes which define the basic approach to a given test: displacement 
control and force control: 

Under displacement control, the displacement of the specimen is predefined. The 
BioTester 6000 stretches the specimen until the predefined displacement is achieved. 
The force required to achieve the displacement is an output of the test.  Several control 
functions are available for displacement control. 

Under force control, the force applied to the specimen is predefined. The BioTester 
6000 stretches the specimen until the predefined force is achieved.  The displacement 
required to achieve the force is an output of the test.  Force control can be applied as a 
ramp or sinusoid function. 

In addition, strain control from image feedback is available for the BioTester 6000. This control 
mode utilizes displacements based on a region within a specimen rather than global actuator 
displacements. For more information on this control mode and how to set up a protocol with this 
mode, see the Strain Control from Image Tracking section below.  
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Control Functions 

The BioTester 6000 makes it possible to test specimens under several control functions: 

Under Displacement or Force control: 

The true strain function (Displacement Control Only) applies the displacement at a 
constant true strain rate, which accounts for the current specimen length while the 
specimen is being stretched.  

The ramp function applies the displacement or force at a constant nominal rate. This is 
equivalent to a constant engineering strain or constant velocity.  

The sine function applies the displacement or force according to a sinusoid with the 
desired displacement magnitude and duration. 

  

       True Strain          Ramp       Sinusoid             Custom     
 
 

Time 

Displacement             

 

 

The control mode, load function and load magnitude can be set independently for each of the two 
loading directions.  
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3. System Overview 

System Components 

The BioTester 6000 brings together several high-precision components, making it the state-of-
the-art instrument for testing biomaterials. 

 
 

The BioTester 6000 

 

 

A High-resolution CCD camera provides 
synchronized video tracking and 
analysis. 

B Illumination and lens provided to 
capture excellent image quality. 

C Our patented BioRake attachment 
method provides quick and easy 
mounting of samples. 

D Integrated machine controls and data 
collection are compact and designed for 
testing flexibility. 

E High resolution control delivers 
precision measurement on small 
samples. 

F A simple USB interface for easy 
connection to the host computer. 
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Software Overview 

The software included with the BioTester 6000 is called LabJoy.  It is divided into two modules, a 
data collection module and a review and analysis module.  The data collection module is used to 
set test parameters, enable specimen loading and testing, and monitor test progress.  The screen 
layout for this module is shown below: 

 

 

Test 
Parameters 

 

 

 

 

 

 

Live Force & 
Displacement 

 

 

    Live Video    Live Charting 

The review and analysis module is used to playback accelerated or decelerated test images, 
perform image analysis and tracking, and output video files for presentation purposes.  The 
screen layout for this module is shown below: 

 

Image List 

 

 

 

 

Image Playback 

 

Image Tracking 

 

 

 

Data Overlay 
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Output Files and Data Structures 

For each test, the BioTester 6000 creates and saves three file types. The following table 
describes the three file types for a project named “Sample1”. Output from this test would be found 
in a “Sample1” output directory (a sub directory of the user specified data directory). 

File Type Description 

.tst file The Sample1.tst file that contains the exact protocol and settings used for the test. 

.csv file The Sample1Data.csv file that contains comma separated numerical data such as time, force and 
displacement values. 

.jpg files Captured images such as Sample1.000010.3.jpg, which would correspond to an image captured 
at 10.3 seconds from the start of the test. 

 

Each test folder will also contain 2 subfolders.  The “Logs” subfolder contains a text file of the 
content of the text dialogue portion of the main screen.  It is useful as reference to troubleshoot 
problems with your system, should they occur. 

The “Tracking” subfolder is initially empty.  If tracking is performed on any of the images in the 
test folder using the “Analyze and Review” software module, there will be data files that contain 
the tracking information stored in this directory.   

While using the “Analyze and Review” software module, you may create additional data files such 
as text files (*.csv) containing tracking results, images with force data or tracking results overlaid 
(*.wmf), or movie files (*.avi).  These additional files can be stored in the test directory or 
elsewhere on your computer’s hard drive without interfering with the software application (once 
created, they cannot be opened by the LabJoy application). 

When working with the data, you should be aware of a few details regarding the data output: 

1. The output specimen sizes are based on the spacing between the BioRake tines and do 
not account for the specimen material outside of the test region. 

2. The software cannot calculate stresses since the thickness of the specimen is not known. 
To calculate stress, you will have to manually measure the thickness of the material 
before or after the test is performed. 

3. Strains can be calculated using the output displacement values (which are based on the 
BioRake tine motions). The specimen may actually be subjected to less strain than the 
calculated values due to attachment site effects and tissue tearing. The image tracking 
module is useful for determining the actual strain values and variations within the 
specimen. 
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4. Setting Up & Starting a Test 

Overview 

Setting up and running a new test is a simple process made up of both mandatory and optional 
steps. The following list presents all the steps, while the rest of this chapter describes each of the 
steps in detail. 

Step 1: Start a New Test 

Step 2: Reset the Actuators 

Step 3: Move the Actuators to a Specified Size 

Step 4: Zero the Load Cells (occasional) 

Step 5: Modify the Test Parameters (optional) 

Step 6: Mount the Specimen 

Step 7: Execute the Test 

Step 8: Terminate the Test Prematurely (optional) 

Step 9: End of Test Controls (optional) 

Step 1: Start a New Test 

 

Launch the LabJoy software, and then 
select Collect New from the File menu.  In 
the Create Test from Template dialogue, 
perform the following steps: 

 

 

1. Select a template that matches the type of test you wish to perform. See the BioTester 
6000 Tip on how to select and use a template. You can modify the template parameters 
in Step 4, below. 

2. Name your test. The dialogue will have a default test name. You can use the default or 
rename the test. Each time you start a new test, the default name will continue to 
increment the number at the end of the name. 

3. If desired, you can change the location of the output data. The location of your output 
data and images is determined by specifying a Test Name and Data Directory. The 
template and data directories are user specific (computer login name). Each system user 
can store their files to a different default location. The system uses the last location 
selected as the default. 
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BioTester 6000 Tip: Selecting and Using Templates 

How to select a template: Designing an appropriate test sequence is an art that 
depends on both the type of material being tested and the specific material properties 
you are interested in measuring. When first testing a new material, you should expect to 
have to experiment with the settings until the test yields meaningful data.  

The system comes loaded with example templates to help you get started. Selecting a 
template does not lock you into a specific test sequence or protocol – rather a template 
defines a test sequence and settings, all of which can be changed before a test is run. 
Once you have developed a test sequence and settings that are appropriate for the 
material you are testing, you should save these settings using “Save As Template” from 
the File menu. You can then select your template the next time you initiate a test. 

Step 2: Reset the Actuators 

We suggest performing an actuator reset at the start of a new test. Also, if you have stopped the 
previous test in mid cycle, then you should reset the actuators. By resetting the actuators, you are 
moving the actuators to the precise home position ensuring that the displacement measurements 
taken by the BioTester 6000 are accurate. 

To reset the actuators, select Reset Actuator from the tools menu, or press  on the toolbar. 

 

If the below warning dialogue appears, select Yes.  This warning is to remind the user not to reset 
the actuator with a specimen mounted. 
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System Alert 

The actuators SHOULD NOT be reset if the specimen is already mounted. Doing so will 
damage your specimen as well as possibly damage the BioRakes or Load Cells. 

 

Step 3: Move the Actuators to a Specified Size 

After the actuators have been reset, they will remain in their fully retracted positions and must be 
moved to specified (reference or starting) positions.  

To move the actuators to the specified position, select Move Actuators to Specified Size from the 

Tools menu, or press  on the toolbar.  The desired size must be entered in the boxes labelled 
Specified Size (um) X Y. 

 

 

Step 4: Zero the Load Cells (occasionally) 

While it is not necessary to zero the load cells with every test sequence, we suggest zeroing the 
load cells at the start of a new test session. With repeated use, the zero point of the load cells can 
drift. By zeroing the load cells, you are ensuring that the force measurements are accurate. 

To zero the load cells, select Zero Load Cells from the Tools menu or press  on the toolbar. 

 

System Alert 

You should not zero the load cells if the specimen is already loaded, or the load cell 
zeroing process will not work properly and an offset will be introduced into your force 
data. 
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Step 5: Modify Testing Parameters (optional) 

You can select and modify parameter 
sets by clicking on their row in the Test 
Sequence table and then pressing the 
Edit Set button (or by double clicking on 
their row). When you do so, the Set 
Parameter Editor dialogue will appear.  

Note that displacements are specified in 
either % strain, or μm. Force loads are 
specified in mN, and durations are 
specified in seconds. 

The following table describes each of 
the parameters.  
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Test Parameter Description 

Control Mode Biaxial tests are typically performed under displacement control; however, you can 
select the following control modes to achieve specific testing objectives: 

• To obtain uniaxial properties for a biaxially mounted specimen, specify 
displacement control in one axis and Force control with zero Load Magnitude 
in the other axis. 

• For creep testing, use a preload with a long hold duration. 

• For relaxation testing, use displacement control with a long hold duration. 

Control Function True Strain (Displacement Control only), Sinusoidal, or Ramp is typically selected for 
tests performed in displacement or force control mode. True Strain tests can only be 
run in displacement control mode.  

Stretch Magnitude  
(Load Magnitude when in 
Force Control mode) 

Selecting a stretch magnitude is entirely dependent on the material you are testing. A 
sound approach is to begin with a small magnitude and iteratively move up to larger 
magnitudes.  

If you are using Displacement control mode, you can specify the displacement in either 
µm or as a percentage. For example, the displacement on a 5000µm x 5000µm 
specimen can be expressed as either 500µm or 10%. 

If you are using Force control mode, you can only specify the force in mN. 

Watch the test results carefully to determine which magnitude setting best achieves 
your test goals. 

Preload Preload is typically reapplied on every repetition during a preconditioning set as well as 
on the first repetition of a testing set. Specimen size is adjusted after a preload 
adjustment. Strain calculations are based on the specimen size after the last preload 
adjustment.  If you are working with a material for which preload values have been 
suggested, you can set the value accordingly. Otherwise, zero is a good initial choice. 

Preload Magnitude As with stretch magnitude, the preload magnitude settings depend on the material you 
are testing. While Preload can be set at zero, typically you would set the preload 
magnitude somewhere between zero and 10% of the peak load you expect to achieve. 

Stretch Duration For evenly spaced images, it is recommended to choose a number that is an integer 
multiple of the Image Output Frequency. 

Hold Duration Hold Duration is typically set to 0, however it is useful for creep or relaxation testing. 

Recovery Duration Recovery Duration is typically set to the same value as the Stretch Duration. 

Rest Duration Rest duration is typically set to 0, however a non-zero value may be used to mimic in 
vivo conditions or for specialized testing. 

Repetitions Apply enough repetitions until the force deformation curves from one repetition to the 
next start to overlie each other. 

Data Output Frequency Typically set to the same frequency as the image output frequency. 

Image Output Frequency Typically set to 1Hz for cycles > 5 seconds and 10 Hz for cycles < 5 seconds. 
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Step 6: Mount the Specimen 

Proper specimen mounting is critical to ensuring accurate and repeatable results. It is best to 
have the tines spaced evenly across the edge of the specimen and as closely to the edges as 
possible. 

To mount the specimen, follow these steps: 
 

1. Place the specimen in the mounting press on top of a backing material such as the 
supplied soft silicon or a piece of foam. 

2. Place the mounting bridge across the fluid chamber. 

3. Partially raise the mounting bridge. 

4. Centre the specimen between the rakes using a small 
implement, such as forceps, and the live video window 
as feedback. Adjustment of the actuators may be 
necessary to ensure the rake tines are positioned 
correctly for non-ideally sized specimens. 

5. Raise the stage until the rake tines are pressing gently 
on the specimen. 

 

 

6. Push all 20 tines into the specimen, either all at once 
using the press block or one at a time using a small 
implement such as a precision screwdriver. 

7. Partially lower the stage and remove the backing 
material. 

8. Fully lower the stage and remove the mounting bridge. 

9. Fully raise the stage to submerge the specimen, if 
desired. Typically, you will want to match a specimen’s 
physiological state, which for most biological materials 
is in a saline solution heated to the organism’s body 
temperature. 

10. To minimize the effect of surface debris and surface 
ripples, a cut-out has been made on the top of the fluid 
chamber that is sized to hold a standard microscope 
slide. 
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BioTester 6000 Tip: Ideal Specimen Size 

The BioTester 6000 is designed for small specimen sizes. For Standard BioRakes (5 
tines spaced at 1 mm) the ideal specimen size is square with side lengths of 5.5 - 6 mm. 
If a specimen is not in the ideal range, it may still be mounted, but the placement of the 
rake tips will need to be adjusted. Also, BioRakes of different size are available and may 
be used. 

Manual adjustment of rake positions during specimen loading may be necessary to 
ensure that the rakes puncture the sample correctly. 

These manual adjustments result in a change in specimen size, which in turn results in 
a change in actuator displacement profiles. The specified specimen size is displayed at 
the top of the screen while the current specimen size is displayed on the left of the 
screen just below the force output.  

At any point before the test has started, specimen size can be changed using one of the 
following methods: 

• Press  on the tool bar, or from the Tools menu select Move Actuators to 
Specified Size 

• Use the Actuator Control jog button 
arrows. 

 
 

 

Step 7: Execute the Test 

Select Execute from the File menu or press the  button on the toolbar. 

Step 8: Terminate the Test Prematurely (optional) 

You can stop a test at any time by clicking  on the toolbar, or by selecting Stop from the File 
menu. This is preferred method as opposed to powering down the equipment, as it allows the 
software to store the current actuator position.  

At the end of the completed test (both normally and prematurely terminated) the actuators will 
maintain their current position. 

 

BioTester 6000 Tip: Specimen Thickness 

Measuring the specimen thickness before and/or after a test is performed will allow 
stress calculations to be made from your output data. 
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Step 9: End of Test Controls (optional) 

Once the test has been completed, you can choose to start a new test or use the system controls 
by selecting the “OK” button.  

 

 

System controls include the top ribbon as well as Actuator Control. These controls can be useful 
if you need to release a specimen from the text fixtures at the end of a test. 
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5. Strain Control from Image Tracking 

Strain control from image tracking is an alternate test control mode that can specify and control 
the test displacements based on a region within a specimen rather than the global actuator 
displacements.  When deforming a specimen, strain values often vary near the attachment sites 
compared to the middle region of a specimen.  This is especially evident when using BioRakes 
which tend to deform more around the rake tine puncture points compared to other parts of the 
specimen.  Clamped specimens usually have lower strains around the clamps because the 
clamps prevent lateral deformations.   

In biaxial testing, strains in the center of a specimen can be significantly less than the actuator 
strains and local strains in the X and Y directions are often different from each other. 

Controlling the applied strain in a region of a specimen is achieved by tracking image features in 
real time during test execution. 

When a template with Strain Control from Image Tracking protocols is opened, the pop-up 
window shown below will appear to indicate so. 

 

Specify Testing Parameters 

To use strain control:   

1. Double click or select Edit on the 
desired protocol line to open Set 
Parameter Editor 

2. Select Strain From Image as the 
Control Mode. This mode will only 
be available if a scientific camera 
set up is connected.   

3. Select Sinusoid or Ramp control 
function. 

4. Magnitude is in % and is calculated 
as the change in length divided by 
the initial length at the start of the 
stretch phase. The initial length is 
updated after preloads. 
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Selecting the Tracking Point Locations 

A test protocol that is using strain control with image tracking will display a rectangle in the live 
video feed as follows: 

 

The small squares are the points that will be tracked.  The location of the tracking points can be 
adjusted by clicking and dragging the corners of the box or the center tracking points on each 
side.  

The average distance between all pairs of points is used for strain calculations.  Tracking is 
performed using a digital image cross-correlation technique with updates at 20 Hz. For strain 
control using image tracking to be successful, there must be sufficient texture patterns or fiducial 
markers present in the images.  Texture patterns can be added to specimens with marking pens 
or a light dusting of graphite or other contrasting powders on the specimen. 

The colour of the tracking box and points can be adjusted in the Strain Control from Image 
Tracking Settings (see below). 

Configuring the Live Charting Graphs 

The strains can be displayed on the live charting graphs when using the strain control from image 
tracking feature. The graphs can display measured strain or nominal strain. 

• Measured Strain is the calculated strain from the image tracking. 

• Nominal Strain is calculated from the motion of the actuators. 

The graph settings can be specified by selecting Graphs from the Settings menu. 
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Configuring Output Data Files 

Measured and Nominal strains are 
available as test output columns for 
the csv data file. From the Settings 
menu, select Data Output.  Then 
click the Configure button to select 
the desired output columns. 

 

 

 

Strain Control from Image Tracking Settings 

To access the settings for Strain Control from Image Tracking, select Settings in the top ribbon 
and Strain from Image. The colour of the tracking points can be modified as well as 
disabling/enabling the pop-up window at the beginning of each test. 
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Executing the Test 

Upon executing a test, the dialog box shown below will appear.  It gives options to automatically 
adjust camera settings and to automatically adjust tracking point locations.  Optimized lighting 
and camera settings and adjusted tracking points locations may improve the success of tracking.  

Click proceed with Test to execute the test. If the software is unable to continuously track a point, 
the test will automatically stop to prevent any damage to the system. If this occurs, more textured 
patterns or unique features may be required to generate better tracking points for the software to 
follow. 
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Advanced Controls 

Strain control from image tracking 
is controlled with a PID control 
algorithm.  The PID control 
parameters can be adjusted by 
selecting Motion Control from the 
Settings menu in the top ribbon. 

 

Check the Edit Advanced Settings 
check box then select Strain from 
Image in the control mode drop 
down menu.  

 

Increase the Kp value if the system 
is not responsive enough or cannot 
achieve the specified strains. 

 

Decrease the Kp value if the 
system is producing unstable or 
oscillating results. 

  

The hardware defaults should work 
under most conditions and can be 
restored with the Reset to 
Hardware Defaults button. 
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6. Additional Settings 

Configuring Output Data Files 

From the Settings menu, select Data Output to display the dialogue shown on the left. Click the 
Configure button to select which of the following columns to output. 

 

→ 

 

 

Output Column Description 

Set Name  User defined name of each set 

Cycle Cycle and Phase information 

Time (S) Time in seconds 

X/Y Size (µm) Distance between opposite pairs of BioRakes 

X/Y Force (mN) Load Cell reading 

X/Y Displacement Reports the change in size relative to the initial size 

Set Name Name specified for each set 

Temperature (°C) Current temperature 
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Advanced Settings 

Advanced settings are available by selecting Advanced from the Settings menu.  All of these 
settings are template specific. 

 

 

Show Warnings 

By selecting the check boxes, a warning dialogue will appear before either action button (i.e. 
Reset Actuators or Zero Load Cells). 

Resetting the actuators with a sample attached may damage the specimen, BioRakes, and/or 
load cells.  To avoid resetting the actuators with a sample attached, a warning dialogue will 
appear after “Reset Actuators” is selected, prompting the user to proceed.   

 

System Stiffness Compensation 

System Stiffness Compensation can be used to compensate for the small displacements that 
occur in the system during testing due to flexion and load cell compression/tension. These 
displacements arise from any strains in the load cell and any bending or deformation of the 
system during loading. Under most loading conditions of the BioTester 6000, these 
displacements are negligible and system stiffness compensation is not required.  It is 
recommended to leave the System Stiffness Compensation as Enable>Auto. 
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Motion Control Settings 

 

 

Velocity (1-10 integer values) matches actuator jog speed and sets the maximum speed at which 
the actuators can travel in a force-controlled mode.  Typically for stiffer materials, this value 
should be between 6 and 8 and for soft materials, this value should be between 8 and 10. 

Acceleration (1-10 integer values). Typically, this should be set to the default value of 10 
(maximum acceleration).  Changes made to the acceleration will affect tests under both force and 
displacement control.  Reducing this value may help smooth force-controlled tests under low 
loads or displacement controlled tests at high speeds.  Tests run with lower accelerations will 
have softer transitions at direction or speed changes but may take longer than specified to 
achieve testing cycles. 

Control Algorithm Settings Editing (Advanced) 

This setting offers the option to change from the programmed adaptive control algorithm to a 
custom algorithm. We recommend using the adaptive algorithm that has already been optimized 
for the BioTester 6000, as improperly tuned PID settings may result in unstable behavior. We 
suggest only advanced users with specialized tests modify these PID settings. Contact CellScale 
for more information regarding these settings. 
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BioTester Tip: Testing Force Control Settings 

It is important to have appropriate Force Control Settings that match the material you 
are testing.   

To safely test Force Control Settings:  press  on 
the tool bar, or from the Tools menu select Move 
Actuators to Specified Load.  The dialogue shown on 
the right will appear.  The BioTester will attempt to 
achieve the specified loads (forces) but will stop 
when either the specified loads are reached, the 
actuators have displaced by the maximum specified 
amount, or the timeout time has elapsed. 
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Range Limits 

Range limits can be accessed by selecting Range Limits from the Settings menu.   

Soft Limits 

To avoid rake collisions or sample 
destruction, it is useful to assign 
reasonable travel limits to the actuators. 
This is especially important during force 
control or preloading, where if specified 
loads cannot be reached, the actuators 
will keep moving until they reach the soft 
limits. 

Min and Max Displacement, in µm, set 
the minimum and maximum positions to 
which the rakes are allowed to move. 

Max Force, in mN, sets the maximum 
value of force at which a test will be 
automatically stopped.  The default value 
is set to the capacity of the load cells.  
Setting this value may be useful to 
prevent sample destruction or 
overloading of the load cells. 
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Configuring the Live Charting Graphs 

The three graphs on the right side of the 
screen provide real-time user feedback during 
a test. These graphs are intended to be used 
for qualitative feedback, not for detailed 
analysis.  

The graphs are updated at a maximum 
frequency of 10Hz; certain short-duration tests 
may not show all the detail that is actually 
present.  

The graph settings can be specified by 
selecting Graphs from the Settings menu. Auto 
scaling allows the axis min and max to start at 
the specified values but expand if the data 
values are larger or smaller than the initial 
limits. 
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Graph Data 

Force versus Time 

This graph shows how the measured X and Y forces 
are changing with time. Peak loads per cycle, 
differences in load between the X and Y axes, and 
force relaxation are all easily seen in this type of graph. 
Force is proportional to nominal (engineering) stress. 

 

Displacement versus Time 

This graph shows how the rakes are moving with time. 
The phases of the test sequence and size adjustments 
due to preloading are readily apparent in this type of 
graph. Displacement is proportional to nominal 
(engineering) strain. 

 

Force versus Displacement 

This graph displays a qualitative representation of the 
material behavior. Viscoelastic effects (like hysteresis) 
and material response to different loading phases are 
apparent in this graph. This graph is proportional to a 
nominal (engineering) stress-strain graph. 
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7. Reviewing Test Results 

Overview  

The BioTester 6000 software has an integrated image analysis module which can be accessed 
by selecting Analyze and Review Images from the File menu, then selecting the appropriate test 
file.  The test file is a text file with a .tst extension that contains information about the test 
parameters so that the software can display the images and data in a useful fashion. 

 

 

Image List 

 

 

 

Image 
Playback 

 

Image 
Tracking 

 

 

Data Overlay 
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Selecting Images 

The Images are shown in a tree structure on the top left panel. 
The tree structure organizes the images by: 

Set (line on the Test Sequence window) 

Cycle (iteration of a given Set) 

Phase (Preload/Stretch/Hold/Recovery/Rest of each Cycle) 

Image (the one or more individual images from each Phase) 

You can select which images to include in a playback set in 
one of several ways: 

• hold down the shift key and click on individual images 

• select entire sets, cycles, or phases (will playback all 
contained images) 

• select images which have data associated with a 
particular tracking set 

 

Image Playback Options 

The controls on the left of the screen are broken into 2 sections: 
Playback and Tracking.  

The playback buttons allow the user to review the images taken during 
a test. 

 

Next/Prev Display next or previous image (as dictated by “Play Every” parameter). 

Play/Stop Start and stop the playback. 

Prev/Next Cycle Jumps to a corresponding image and phase in the next or previous cycle. Useful when reviewing 
sets that have multiple cycles. 

Loop Sequences can be played continuously in a loop or only once. 

Playback Rate +/- changes the speed of the playback. A playback rate can also be manually entered in the 
display box. 

Play Every Allows the users to skip some frames to expedite playback. 
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Image Tracking: Overview 

Image tracking is a function that can be used to quantify the 
motions of image features (rake tines, specimen texture and 
fiducial markers). This can be useful for studying localized 
specimen deformations, verifying strain magnitudes, and 
comparing the results of one test to another.  

The image tracking engine is based on a template matching 
algorithm. This algorithm starts by defining a “patch” of pixels 
(called a template) surrounding the selected source point on the 
source image. It then determines the optimal location for this 
template on a target image within a specified search region.  

 

The algorithm defines the location of the tracked point on the target image as the centre of the 
optimally located template.  

To track an image, follow these steps: 

1. Click the Create button in the 
tracking window, shown above. 
This brings up the Tracking Editor 
dialogue box. 

 

2. Enter a Tracking Name. 

3. Select the Source Image in the 
test image list tree, and click Set 
to the left of the Source box. 

4. Select the Target Images in the 
test image list tree, and click Set 
to the left of the Target box. The 
target image list will automatically 
be sorted to remove duplicates 
and be put in sequential order. 

5. Generate source points on the 
source image by performing the 
following steps: 

a. Manually click source point 
locations on the source image 

 with the Add button depressed. 

b. Draw a box on the source image with the Select button depressed, then click the 
Grid button and define a grid of points. 

The displayed image will automatically change to the source image when either the Add 
or Grid buttons are depressed. 
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6. Modify search parameters: 

Source 
Template 

The optimal source template is difficult to predict, but in general it is 
advantageous for the template to be large enough that it contains at 
least one feature, but not so large that it contains multiple features.  
Typical values for this parameter are between 15 and 55, with 35 
being a good starting point for most users. 

Search Region The search region needs to be large enough that the optimal 
location for the template is found. In general, no part of the 
specimen moves more than the rake tines, so the motion of the 
rake tines is a good guideline for how large the template needs to 
be.  For example, if the rake tines move 50 pixels over the 10 
frames you are interested in, it is unlikely that any part of the 
specimen is moving more than 5 pixels/frame and so a good value 
for the search region parameter would be 11 (5 pixels each way, 
plus the center pixel). 

Use Source 
Template From 

First Image tracks all images against the first in the series (1→2, 
1→3, 1→4…). 

Previous Image tracks each subsequent image against the image 
before it (1→2, 2→3, 3→4…). 

First Image Tracking tends to have poorer correlation than Previous 
Image Tracking because the current image is usually closer in 
content to the previous image than it is to the first image in the 
sequence. Previous Image Tracking tends to have good correlation 
for each individual step, but is prone to error accumulation since 
each step is independent. The best method for a given data set will 
depend on the number of images and the content of the images.  
Sometimes it is best to use Previous Image Tracking but to only 
use every other image or every nth image rather than all the images 
available. Sometimes it is best to use First Image Tracking and use 
every image but set the source image in the middle of the image 
series rather than at the beginning.   

Set Search 
Region Centre 

New Point Locations The location of the center of the search 
region is set to the same location of that point in the previous image 
(even when the source template is from the first image). 

Use Strain 
Based 

Deformable 
Templates 

When this option is checked, the source template will be scaled 
(resized) according to strains calculated from the test Size X and 
Size Y parameters. Best tracking results are often obtained when 
using this option. This option may not be the best for uniaxial tests 
or tests where the specimen deformation is non-uniform. 

7. Perform tracking with either Track All Points or Track Selected Points. 
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Image Tracking: The Points Display Option 

The Points Option displays the points in their current 
location (i.e. their location on the currently displayed 
image) with or without gridline connecting points that 
were generated using the grid function.  

Clicking the details icon brings up the window shown 
to the right. Options include changing the point radius 
or color, showing ID numbers and showing gridlines 
with or without ID numbers.  

Gridline ID numbers are associated with each grid 
square (cell), while Point ID numbers are associated 
with the points themselves. 

Tracking display settings default to the last used 
settings. 

 

 

Figure 1: Initial tracking grid displayed as 
points. 

 

Figure 2: Tracking to 20% strain displayed as 
points. 
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Image Tracking: The Displacement Option 

The Displacement Option displays the points in their 
current location as well as graphically representing their 
motion through time.  

Clicking the details icon brings up the window shown to 
the right. This dialogue allows the user to change the 
reference image, change the type of connecting line, 
and change the line appearance.  

Displacement connecting lines directly connect the 
reference and current points via a vector or a path. The 
path option provides more information but can result in 
slow playback speeds for sets with many points and/or 
many images.  

The Flow option generates a direction vector based at 
the current location and oriented in the direction of 
motion relative to the reference image. This can be 
useful because the length of this vector can be scaled 
to better visualize small displacements. 

Tracking displacement settings default to the last used 
settings. 

 

 

 

 

Figure 3: Tracking to 20% strain displayed as displacement. 
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Image Tracking: The Strains Option 

The Strains Option can only be used in conjunction with 
a grid of points (as opposed to individually placed 
points). This option calculates the regional strains 
inside every grid box and displays this data as an 
ellipse. One can imagine this is what would happen to a 
grid of circles drawn on the surface of the specimen at 
the beginning of the test. 

Clicking the details icon brings up the window shown to 
the right. This dialogue allows the user to change the 
reference image as well as the appearance of the 
circles and text.  

Showing text for E1, E2 will result in the text showing 
the strains along the major and minor axis of the 
ellipse. Showing text for Ex, Ey will result in text 
showing the strains along the X and Y directions 
regardless of the ellipse orientation. 

Tracking strain settings default to the last used settings. 

 

 

 

 

 

 

 

Figure 4: Tracking to 20% strain displayed as 
strain ellipses. 

 

Figure 5: Tracking to 20% strain with text 
showing x% strain. 
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Data Overlay 

Data associated with each image is displayed below 
the tracking controls on the left side of the main 
window.  Checking the Show Graph box displays this 
data as a graph overlaid on the images 

 

 

Clicking the details icon displays the window shown to 
the right. The dialogue allows the user to change the 
size and appearance of the overlaid graph. The data 
points associated with the current image are marked on 
the graph with green circles. The overlaid data graph 
will be drawn on top of any image tracking displays 
(when they overlap). 

Data Overlay settings default to the last used settings. 

 

 

 

 

 

 

Figure 6: Tracking to 20% strain with overlaid x-y force graph. 
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Exporting Tracked Data 

Tracked grid point coordinates and calculated grid 
strains can be exported to a .csv file. From the Export 
menu, select Data Points to display the dialogue shown 
on the right. The image list is automatically set to the 
currently selected images in the test image list tree.  
This image list can be changed by selecting new 
images in the test image list tree and pressing the set 
button. When exporting Strains data from Selected 
Tracking Points, all four points of a grid cell need to be 
selected for data from that cell to be exported. 

Exported data is labeled with associated ID numbers 
(grid point ID numbers for exported coordinates and 
grid cell ID numbers for exported strain values).  To 
display ID numbers on tracking grids see Image 
Tracking: The Points Display Option.  In the following 
example (Figure 9), grid point ID numbers are shown in 
yellow and grid cell ID numbers are shown in white. 
When exporting data for the selected points as shown 
in red, coordinates are exported for points with ID 
numbers 5, 6, 7, 8, 9, 10, 11 and 12, and strains are 
exported for grid cells with ID numbers 4, 5, and 6. 

The exported .csv file is written to the test directory.  

 

 

 

Figure 7: Tracking Grid showing ID Numbers. 

 

Figure 8: Sample Exported Data. 
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Exporting Images and Movies 

The current Image view, including all displayed tracking 
grids, tracking data and overlaid data can be exported 
as a metafile by selecting Current Image from the 
Export menu.  Alternately, the current image view can 
be copied to the clipboard by selecting Ctrl-C from the 
keyboard. 

To export a series of image views, including all 
displayed tracking grids, tracking data and overlaid 
data as an .avi movie, select Movie from the Export 
menu.  The dialogue shown on the right will be 
displayed.  The image list is automatically set to the 
currently selected images in the test image list tree.  
This image list can be changed by selecting new 
images in the test image list tree and pressing the set 
button.   Options are available for setting the fame rate 
or image size (resolution), adding filenames, and 
choosing color or grayscale output.  Compression 
options are also available. 

 

 

 

Importing and Analyzing Non-BioTester 6000 Images 

The LabJoy software can be used to perform feature displacement tracking and strain tracking 
on .jpg images using the “Import Images” function located in the File menu.  To use this 
feature, select the desired images using the shift/ctrl keys in the dialogue box or else select the 
directory to import all of the contained images. 

Once the images have been imported, the software works much the same as with BioTester 
6000-generated images.   
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8. System Hardware Settings 

Controller 

The BioTester 6000 uses an integrated control board 
rather than a group of PC controlled device drivers. 
This minimizes communication lag and allows the 
device to operate asynchronously with the PC. The 
control board details can be seen by selecting 
Hardware from the Settings menu, which brings up the 
window shown to the right. 

 

 

 

Camera 

The camera uses a 2/3” monochrome CMOS sensor to 
obtain a resolution of 2048 pixels by 2048 pixels. The 
camera shutter and gain can be controlled during the 
setup phase of the test. 

The camera captures images at 15 frames per second 
during every test and writes these images to a buffer. 
The test controller extracts images from this buffer at 
the frequency specified in the Set Parameter Editor 
(15Hz, 5Hz, 1Hz, 0.1Hz, 0.01Hz, or 0.001Hz). These 
images are written to the output directory. The file 
name is the ideal capture time. The actual capture time 
may differ from the ideal capture time by as much as 
1/30 of a second since the images are extracted from a 
buffer.  

 

The test software creates an image capture log file in the output directory should this difference 
be significant. This log stores the actual capture time and the idealized capture time. 

The camera default shutter and gain are specific to each test template and can be set by 
selecting the Camera tab in Hardware from the Settings menu. The recommended maximum 
shutter speed is 10mS.  Typically, the camera iris is left fully open and the shutter and gain are 
adjusted to achieve the desired image brightness. 



BioTester 6000 User Manual 

42 

 

Load Cells 

The load cells are semiconductor strain gage-based 
with mechanical overload protection (for the lower 
capacity load cells). They have an accuracy equal to 
0.2% of the rated full scale load. The load cells are 
available in 0.5N, 1.5N, 2.5N, 5N, 10N, 23N, 45N, 
110N, and 200N sizes. Each load cell has a unique 
calibration factor which is stored in a chip attached to 
the load cell connector. 

While the load cells should not have significant 
hysteresis or thermal drift, but temperature changes or 
prolonged loading can introduce small offsets. It is 
recommended that the zero load state be redefined 
periodically. This can be done by selecting Zero Load 

Cells from the Tools menu or pressing . 

 

The load cells are sampled at 100Hz, with hardware sample averaging to reduce noise in the 
data. Further sample averaging can be implemented by selecting Advanced from the Settings 
menu. 

Each load cell is calibrated and has a specific calibration factor which is stored on a chip in the 
load cell connector. The range and calibration factor can be viewed by selecting Hardware from 
the Settings menu, but are not user controlled.  In addition, the load cells need to be calibrated 
when the system is initially set up and whenever load cells are changed or re-mounted.  See 
Section 8 of this manual for this procedure. 

 

System Alert 

Though they have some mechanical overload protection, the load cells are sensitive to 
excessive torque, excessive overload, transverse loading, and bending forces.  
Such forces may permanently damage the load cells. Care should be taken to apply 
force to the goosenecks only in the linear direction within the rated load of the load cells 
being used.  Also, the load cell stud should not be overtightened. 
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Heater 

To activate the fluid chamber heater, both power 
switches on the front of the BioTester 6000 need to be 
in the On position (the computer and software do not 
need to be on yet). At this point, the heater will warm 
the fluid to the last used temperature set point. The 
temperature set point can be changed by selecting 
Hardware from the Settings menu.  

Typically, the heater will take 20 to 40 minutes to warm 
a full fluid chamber from room temperature to 37°C and 
will take up to 90 minutes to stabilize at this 
temperature. 

When Show Temperature Warnings is enabled and the 
Current Temperature is not at the Temperature Set 
Point plus or minus the specified tolerance -- a red 
indicator button will be displayed next to the Current 
Temperature live output and a warning dialogue will 
appear when you execute the test. 

The Control Settings (PID) section displays the 
programmed settings for the temperature control of the 
heated bath. These have already been optimized for 
the BioTester heated bath. This section only displays 
the setting values (i.e. cannot be edited) to ensure the 
correct values have been programmed. 

 

 

 

 

System Alert 

In the event of a dislodged or faulty temperature sensor, or if there is a lack of fluid in 
the fluid chamber, the system is designed to reach a maximum temperature of 80°C. 

 

 

 

Caution: Avoid touching the specimen stage when the heater is on, it can become 
very hot! 

 

BioTester 6000 Tip: Preheat Fluid 

You can add preheated fluid to the fluid chamber to reduce warm up time. 
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External Sync Pulse 

A 5-volt TTL external sync pulse signal can be 
generated on BioTester 6000 models containing a BNC 
connector jack on the back panel. 

The sync pulse will be pulsed on the very first sample 
pulse, which occurs when the load cells are measured 
and the motor positions of all 4 axes are read.   
Thereafter a sync pulse will occur at a user definable 
frequency as fast as 100 Hz (1 pulse every 10 mS) and 
as slow as 0.00305 Hz (1 pulse every 327 s). The sync 
pulse will stop when the sampling has been stopped. 
 
The sync pulse is active high for 10 mS except when 
operating at maximum speed (100 Hz) where the active 
high pulse duration is about 550 nS. 
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9. System Calibration and Advanced Tools 

Load Cell Calibration 

 

 

 

If the load cells are changed, moved, or impacted, it is good practice to perform the load cell 
calibration routine. This calibration can be performed in the following steps: 

1. Launch the calibration utility by selecting Tools, Advanced, then Load Cell Calibration 

2. Input the K value (spring constant) for the calibration spring provided for the load cell 
being used.  This value is shown on the spring case label (provided upon system 
delivery) 

3. The load cell capacity should be automatically read and displayed, and the appropriate 
calibration preload calculated 

4. Lower the fluid chamber and install the calibration spring brackets on the goosenecks. 

5. Zero the load cell using the Zero Load Cells button. 

6. Using the Jog+ and Jog– buttons, drive the actuators until the posts are correctly spaced 
so that the calibration spring can be installed without applying any significant load.  Set 
the calibration spring on the posts (see above figure).  The spring should be set level and 
in line with the goosenecks. 
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7. Using the Jog+ and Jog– buttons, move the actuators 
until the spring is carrying a tension that is out of the non-
linear “dead zone” and reaches the appropriate preload.  
The current force reading for each axis is displayed in the 
lower left of the LabJoy main screen.  
  
For most setups, the spring should be driven to 30% of 
the load cell rating i.e. for a 2.5N load cell, a preload of 
750mN is specified.  However, for the 0.5N load cell only, 
a preload of 60% of the load cell rating is required 
(300mN).  If it is suspected that the load cell is more than 
15% out of calibration, contact the manufacturer for 
another recommendation for calibration pre-load. 

 

 

 

8. Visually verify that the spring is loaded in a stable, horizontal, and in-line position. 

9. Click the Run button, wait for calibration to complete. 
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10. A new calculated calibration factor will be displayed in the Calculated field. The Previous 
field shows the previous calibration factor (i.e. the factor currently programmed to the 
load cell). 

11. Click the Use Calculated button to apply the calculated calibration factor. Alternatively, 
you may choose to select the Use Previous button to continue using the previous 
calibration factor. 

12. The load cell calibration procedure must be carried out for both the X and Y axis. 

 

Snap Image Feature 

Located under >Tools>Snap Image 

This feature allows the user to capture a single image during the setup phase.  This can be useful 
for documenting specimen loading activity and neutral (non-contact) beam position. 
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Adjusting the Camera Position and Image Magnification 

The horizontal camera position can be adjusted using the knobs at the back and side of the 
camera housing.  If larger position adjustments are needed, the camera mast can be rotated to 
allow alignment of the camera image with the testing axes. 

The BioTester 6000 comes equipped with a 10X zoom lens as shown below. Other versions of 
the BioTester 6000 may be equipped with a fixed magnification 75mm focal length lens (see 
Appendix E).  

The image magnification can be changed by rotating the adjustable rings found on the lens. Once 
the rings are adjusted to the desired settings, they can be locked using thumb screws. Adjusting 
the three rings has the following effect: 

 
1. The iris ring changes the 

brightness of the image. It is 
recommended to leave this 
ring fully open and control 
image brightness by adjusting 
the camera shutter and gain in 
the Camera tab of the 
Hardware Settings. 

 

2. The W – T ring changes the 
lens zoom. 

 
 

3. The F – N ring changes the 
lens focus.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Using this lens, it is possible to achieve a wide ranging field of view as shown in the graph below.  
Possible values for field of view are shown by the shaded gray region of this graph and can range 
from 5.5mm to 24mm.  To adjust the working distance (vertical position of the lens and camera 
assembly), loosen the fasteners that clamp the camera housing to the mast and raise or lower the 
camera then retighten the fasteners. The ideal working distance from the specimen to the lens is 
15cm. It is not recommended to have the lens any closer than this.  

If the camera position or magnification is changed, it may be useful to capture a single image 
scale shot.  A glass calibration target or a ruler is acceptable for this purpose.  The scale shot will 
be useful later to characterize the size of test specimens or test specimen features. 

Iris Ring 

 

W-T Ring 

 

F-N Ring 
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Update Firmware 

 

Periodic firmware updates may be issued by CellScale for the BioTester. Updates are available at 
https://www.cellscale.com/downloads/.  

 

The device firmware will automatically update as part the software installer if your device is 
connected via USB and powered on. 

 

You may update the firmware for your device at a later time if it is not available when updating 
your software: 

1. Connect your device via USB to your computer and power it on 
2. Run the UpdateFirmware.exe located under 

CellScale>LabJoy>Software>Utilities>Update Firmware 
 

 

 

https://www.cellscale.com/downloads/
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10. Troubleshooting 

Image Appears Out of Focus 

With the live image on the screen, adjust the lens focus until the image appears to be in focus.  

Whenever you adjust the focus, the image magnification may change slightly. If you want to know 
the absolute scale of your Images you can snap an image of a calibrated target (such as a 
precision graticule or ruler) by selecting Snap Image from the Tools menu. You can estimate the 
image scale by comparing the number of pixels between rake tips in the images with their known 
µm spacing (size) in the data output files.  

 

ERROR - Sample Buffer Overflow Continuing Test...  

Or 

System Lagging, Camera Frame Lost missed capture 

These errors can be caused by lack of data throughput to the location where the test data is 
being saved.  This has been noted by users who are saving their data to a network drive or a 
USB-connected external hard drive.  Another cause for these errors can be a lack of computer 
resources, especially at high image capture frequencies (5 or 15Hz).  It may be necessary to 
upgrade the computer that is controlling the device. 

 

Communication Errors: ReadFile failed with error 6. 

When communication errors occur the live message window will display a ReadFile failed 
message. Communication errors can occur if: 

• The BioTester 6000 is not powered up. 

• USB cables between the computer and BioTester 6000 are disconnected. 

• The supply power surges or is interrupted.  

When a communication error occurs, close LabJoy, check connections, power cycle the 
BioTester 6000, and restart LabJoy.   

 

BioTester 6000 Tip: Preventing Power Disruptions 

We recommend plugging the BioTester 6000 (and host computer) into an 
uninterruptable power supply (UPS) or battery back-up. 
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11. Appendix A: Initial System Setup 

The BioTester 6000 has been packed in a special container to protect it during shipping.  In 
addition, system accessories have been packed in several cartons contained in a separate box.  
The system components listed below may be unpacked and laid out before system setup.  A 
space 60cm x 60cm with 100cm overhead clearance is required for setup. 

The setup below details the assembly of a BioTester 5000 system.  The BioTester 6000 is nearly 
identical.  A separate setup document is provided noting these differences. 

Tools 

Small flat head screwdriver 

SAE hex wrenches:   1/16”, 3/32”, 7/64”, 9/64”, 5/32”,5/16” 

Metric hex wrenches: 2mm, 2.5mm, 3mm 

SAE Combination Wrench 5/16” 

 
Fasteners & Parts 

1 BioTester 6000 main unit 

16 M4 x 10mm Socket Head Cap Screws 

6 6-32 Hex Nuts (4 + 2 extra) 

20 BioRakes (5 sets of 4 each) 

2           Load Cells 

1 Calibration Spring 

2 Calibration Spring Brackets 

1 Camera Lens (10X Zoom) 

1 Specimen Mounting Bridge 

2 Load Cell Goosenecks 

2 No-Load Cell Goosenecks 

2  Load Cell Brackets 

1 Standard Specimen Cutting Jig 

4 Razor Blades for Cutting Jig  

             (2 + 2 extra) 

1 Fluid Bath 

1 Power Cord and Supply 

1 6’ (1.8m) USB Cable 

1 Set of Shims (Thin and Thick) 

1  Press Block 

1 Sheet of Rubber Backing Material 

4           Actuator Caps 

1           3”x1” Microscope Slide 

1           Pull knob 

1           Temperature sensor 

1           Set extra fasteners 
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Unpack System 

Remove the BioTester 5000 from the shipping container 

Carefully remove the protective shipping material from the container such that the BioTester 6000 
can be lifted out.  Remove the camera mast first then the BioTester 6000 main unit. In addition, 
protective foam will have to be removed from the main unit and camera mast after lifting out the 
BioTester 6000. 
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Attach Camera Mast 

Thread the camera post into the receiver.  The knurled collar must be rotated to fasten the 
camera post.  It will take many turns but eventually the mast will lock into place.  Try to position 
the camera approximately as shown, although the final position can be adjusted later in the 
procedure.  Be sure to position the cables from the camera mast post towards the back where the 
power entry panel is located. 
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Once the camera mast is in place, the cables for the lights and camera USB will be routed out the 
back of the mounting pole.  The camera USB can be plugged into the PC and the connector for 
the lights can be plugged into the back panel of the BioTester 5000. 
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Place Fluid Chamber on Riser Stage 

Put the fluid chamber in place on the riser stage and align the temperature probe mounting hole 
with the temperature probe cable. 
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Install Camera Lens 

Remove the protective caps on the lens and camera body and then screw the lens onto the 
camera. The correct camera setup can be fine-tuned at a later step. If using a fixed focal length 
lens (typically 75mm), see Appendix E for installation.   

 

 

 

 

 

 

 

Lens (10X Zoom) Camera (inside housing) 
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12. Appendix B: Software Installation 

 

A Windows based PC (Windows 10) with at least 2 USB ports is required to operate the 
BioTester 6000. A label on the cover of the manual contains a web address to download the 
LabJoy installation package. These files contain the software installer for LabJoy, which is the 
user interface and control software for the BioTester 6000.   

To install the software: 

1. Go to the provided web address and download the compressed installation package.  
2. Transfer this file to the computer which will be running the BioTester device.   
3. After this is complete, go to the uncompressed installation folder and select LabJoy 

Installer.exe.  Details of typical dialogue boxes are shown below. 
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If your BioTester is detected this screen will popup: 

 

If BioTester is not detected, then you will be taken to a model selection screen where you can 
select your BioTester model. To install the correct user manual and templates please select the 
appropriate model. 
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13. Appendix C: Install Load Cells / Perform 
Camera and Gooseneck Alignment 

 
Connect the camera USB cable to a PC USB port.  Connect the included USB cable to the main 
unit and a PC USB port.  Plug in the power supply to the BioTester 6000 and then proceed with 
the following steps.  Do not turn the BioTester 6000 on yet. 

 

Attach the Load Cells to the Goosenecks 

 

Ensure the correct orientation of the load cell components as shown in the below pictures.  
Tighten the nuts gently to avoid damaging the load cells (just a little bit tighter than finger tight).  
Keep in mind that the load cells are sensitive to excessive torque, excessive overload, 
transverse loading, and bending forces. 
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Attach the load cell stud to the load cell using your fingers.  The load cell stud has one side with a 
shoulder below the threads which should be attached to the load cell.  The other end is attached 
to the gooseneck. If the orientation of the stud is reversed, the load cell may not function 
properly. 
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Attach the other end of the load cell stud to the gooseneck.  Finger tighten a 6-32 nut onto the 

threaded stud.  The load cell cable should be at about a 45° angle to the gooseneck as shown 

below.   
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The load cell and gooseneck assembly should look like this when assembled.  There are two 
styles of load cells available (both are shown below). 

 

 

The nut may be gently tightened against the gooseneck using the included wrench, while 
grasping the gooseneck only to avoid transmitting torque through the body of the load cell.  

 

 

 

Check that all components are snugly in place by gently turning the base of the load cell against 
the gooseneck.  All components should be finger tight while being snug enough so that the 
components don’t freely rotate while using the BioTester 6000. 
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Attach the Load Cell Brackets to the Actuators 

Before attaching the load cell/gooseneck assembly, install the load cell brackets onto the 
appropriate actuators (these are located on either side of the camera post and will be sitting lower 
in the actuator housing).  Use M4 x 10mm (x4) fasteners provided for each bracket as shown 
below.  
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Attach the Goosenecks to the Actuators 

Attach each load cell/gooseneck assembly to the load cell bracket on the appropriate linear 
actuator using a 6-32 nut.  The load cells are attached to the actuators on either side of the 
camera post.  See the following images. The nut on the back of the load cell is not as sensitive as 
the front side nut and may be snugly tightened using the wrench, while grasping the body of the 
load cell.  Make sure that the gooseneck is rotated such that it is level when the nut is fastened. 
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Attach the 2 remaining goosenecks to the appropriate linear actuators using M4x10 fasteners (x4 
each). 
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Stow Cables and Plug in the Load Cells 

Before connecting the load cells, stow the cables inside the plastic cover beside the actuators, 
taking care to handle the connectors by the edges.  A circuit board assembly may be attached to 
the connector and must be handled carefully.  Also, the load cells may have a coiled length of 
cable which must be carefully stowed. The initial length of cable should bend towards the outside 
edge of the BioTester 6000 as shown.   

Position the cables inside the cover so that they do not interfere with the actuator carriage travel, 
particularly during actuator reset where the carriages are fully retracted.  Plug in the load cells 
and stow the connector inside the cover as well.  

Also use care when unplugging the load cells.  This may be done by firmly pressing on the latch 
mechanism before pulling it apart.  See below photos for reference. 
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Attach the Temperature Probe 

Attach the temperature probe and place it in the sensor pocket in the fluid chamber. 

 

 

Attach the Knob to the Pull Rod 

A small knob screws into the pull rod at the front of the BioTester 5000.  This pull rod is used to 
raise and lower the stage. 

 

 

Turn on the BioTester 5000 

Plug the provided power supply into the BioTester 5000 and a standard electrical outlet.  The 
BioTester 5000 has 2 switches.  The “Main” switch turns on the BioTester 6000 main unit and 
lights.  The “Heater” switch turns on the heater below the stage and may be used to warm fluid 
inside the fluid chamber to the temperature specified in the software.  For the heater to be used, 
the main switch must also be activated.  However, the heater is not required to use the system.  
For the set up procedure, turn on the “Main” switch only and check that the LED lights turn on. 
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Launch the LabJoy Software 

Launch the LabJoy software.  The default screen should appear as: 

 

 

 

Selecting File>Collect New should bring up this window: 
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The details of the software are outlined in this user’s manual. For assembly purposes, it is only 
required that we initiate the default test.  Select OK. 

 

If prompted to Reset Actuators, select “Yes”. 

If prompted to Calibrate Load Cells, select “No”. 

 

Next place a standard size BioRake (1.0mm spacing, blue caps) in each of the 4 goosenecks so 
that the BioTester 5000 looks like this: 
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On the LabJoy control screen, ensure that the specimen size is set to 5000µm in X and Y and 

then click the Move to Size button . 
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Perform Camera Alignment 

The camera position has both coarse and fine position adjustments and coarse and fine focus 
adjustments.  To start, loosen the fasteners which tighten to camera cover to the mast.  Position 
the camera cover vertically such that the working distance from the lens surface to the BioRakes 
is 15cm.  Next, adjust the zoom and focus rings on the lens until the BioRake tines are brought 
into focus.  The camera assembly can then be rotated until the camera is positioned 
approximately over the center of the 4 BioRakes.   

To achieve different ranges for field of view, the camera cover can be moved up and down to 
change the working distance but a 15cm working distance will accommodate most applications. 

Be careful to move the camera housing gently in small increments, supporting it with your hand at 
all times, so as not to crash it into the goosenecks or BioRakes.  
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Attempt to bring all of the BioRakes into the image, as shown below: 

 

 

Next, fine tune the camera position using the knobs at the back and side of the camera housing 
and fine tune the image focus using the lowest ring on the lens. 
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Adjustments to the zoom can be made by adjusting the middle ring on the lens. See the section 
on “Adjusting the Camera Position and Image Magnification” in section 8 of this manual for more 
detail. 

  

Iris 

(fully open) 

 

Zoom 

 

Focus 
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Perform Vertical Gooseneck Alignment 

 

Because the goosenecks attached to the load cells are connected by only 1 threaded stud, the 
vertical and transverse alignment of the end of the gooseneck can be somewhat different each 
time the goosenecks are removed and reattached.  To accommodate the vertical variation, shims 
between the gooseneck brackets and the actuators may need to be added or removed.  Thick 
and thin shims are provided (2 thins shims = 1 thick shim).  At this stage, do not be concerned 
with the transverse or axial positioning of the goosenecks as these will be aligned in subsequent 
steps. 
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By looking at the BioRakes from the side, it is possible to observe their vertical alignment.  Please 
add or remove shims to vertically align the BioRakes.  Here are photos of poor vertical alignment 
and good vertical alignment: 
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Perform Transverse and Axial Gooseneck Alignment 

 

This step requires 2 different adjustment mechanisms.  The goal is to make the BioRakes look 
like this: 

 

 

First, make sure the BioRakes are positioned in the transverse center of the gooseneck.  The 
magnetic mounts that hold the BioRakes to the gooseneck fix them in the axial direction, but 
allow a small amount of adjustment in the transverse direction.  This is useful for alignment during 
regular testing, but for the purposes of gooseneck alignment they should be in the neutral 
position.  The first image below shows a transversely offset BioRake and the second shows a 
transversely centered BioRake. 

 

 

 

 

To transversely adjust the goosenecks, loosen the fasteners that attach the goosenecks to the 
actuators, slightly rotate the gooseneck, and retighten the fasteners.  The on-screen image 
should be helpful as a guide.  The goal is to make the rake tines of opposing BioRakes collinear. 
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To axially adjust the goosenecks, use the actuator jog icons in the lower left of the screen.  Make 
sure the “independent” radio button is selected and not the “mirror matching” button.  The jog 
speed should be about 7.  The goal is to make a square as shown in the figure above. 

 

Adjust all 4 goosenecks until you are satisfied with their transverse and axial alignment and the 
rake tips form a square as shown above.  It may also be necessary to make small adjustments to 
the camera position.  The camera alignment should be parallel to the rake alignment and the 
BioRake tips should be in the middle of the image.   

It is now necessary to perform a center position calibration.  First, it will be necessary to 
temporarily define the current position as the center position.  This calibration can be performed 
in the following steps: 

1. Lower the fluid chamber and remove the BioRakes. 

2. From the Tools menu select Advanced and then select Centre Position Calibration.  This 
should bring up this dialogue box: 

 

3. Press Yes. 

4. Select the Reset Actuators button  (or use Tools>Reset Actuators). 

5. From the Tools menu select Advanced then select Move to Centre.  This should bring up 
this dialogue box: 

 

6. Press Yes.  Once the actuators have stopped moving, put 2 opposing BioRakes on the X 
axis. 

7. Using the actuator jog control arrows at the lower left of the screen, move the actuators 
until all 10 BioRake tips are collinear.  Make sure the “mirror matching” button is 
selected for this step and not the “independent” button!  Note that it is the tips of the 
BioRakes that should be collinear and not the outside edge.  Because the tips are 
underneath the BioRakes and cannot be seen on screen, it is necessary to estimate their 
position.  Please use the image below as a reference: 
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Example 1: BioRakes have too much overlap. 

 

Example 2: BioRakes are correctly positioned. 

 

Example 3: BioRakes do not have any overlap so tips are not collinear. 
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8. Remove the BioRakes and place them on the Y axis. 

9. Using the actuator control arrows, drive the Y actuators until all 10 BioRake tips are 
collinear as in step 4 (IN MIRROR MATCHING MODE ONLY!). 

10. From the Tools menu select Advanced and select Centre Position Calibration.  This is the 
final Centre Position Calibration after temporarily assigning this position in step 2.  This 
should bring up the following dialogue box: 

 

 

 

 
11. Press Yes. 

12. Select the reset actuators button  (or use Tools>Reset Actuators). 

 

To check the center position calibration, use the Tools>Advanced>Move to Centre command and 
place 2 opposing BioRakes.  Compare the position of the rakes to the image in step 7 above. 

After a successful center position calibration, the actuators can be successfully moved to a given 
sample size before beginning a test (for example, 4700um x 4700 um) and the tips should form a 
square. 
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Install Actuator Covers 

Each actuator cover has a number written on the inside.  These numbers match up with numbers 
written on the inside of the main cover to ensure the best possible fit between the actuator covers 
and the main cover. 

 

The best way to install the covers is to place the back 2 pegs into the main cover and then lower 
the front 2 pegs while squeezing them together. Be careful not to let the cover slip and 
accidentally apply a transverse load to the gooseneck. 

 

 

 

Perform Load Cell Calibration 

The final step is to perform a load cell calibration. This procedure is detailed in Section 8 under 
Load Cell Calibration. 

  



BioTester 6000 User Manual 

87 

 

14. Appendix D: Mechanical Grip Usage 

Installing Grips  

In addition to BioRakes, the BioTester 6000 can optionally be equipped with mechanical grips for 
sample attachment. 

The mechanical grips can be equipped with three different springs of varying stiffness to exert 
different gripping forces.  These springs are provided with the grips and may be switched at any 
time using the provided hook tool.  

The light, medium and heavy springs will exert 1.5N, 6N, and 15N of gripping force respectively.  

 

System Alert 

Select the appropriate grip spring for the load cell in use. Using a grip with the stiffest 
spring in combination with a low capacity load cell (0.5-2.5N) may produce high forces 
when mounting a sample.  Load cells can be damaged by large off-axis or bending 
forces. 

 

The grips can be attached using the following steps: 

1. Slide the grips onto the goosenecks as pictured below. 
2. Tighten the locking fastener to hold the grips in place on the gooseneck. Do not over-

tighten the locking fastener as this may push the tip of the grip out of alignment. 
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Sample Mounting 

Squeeze the grip levers to open the jaws of the grip.  Slide the end of a test specimen between 
the jaws and gently release the levers.  Specimens may be mounted and tested using 2 grips 
(uniaxial) or 4 grips (biaxial).  
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System Alert 

When squeezing the grip levers to open the jaws, exert force as much as possible in a 
linear direction through the body of the load cell to avoid off-axis or bending forces. 

 

 

Figure 9 - Uniaxial Test Setup 

 

 

Figure 10 - Biaxial Test Setup 
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Changing Grip Springs 

 
1. Using the hook tool provided, pull on the spring and remove the metal dowel holding the 

grip spring in place. After this step, the spring may be slowly released. 

 

System Alert 

A fully installed spring experiences a high amount of tension.   When the springs are 
disengaged, be sure not to let the hook tool slip or the spring may be released at high 
velocity. The use of safety glasses is recommended. 
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2. Replace the old spring with a new spring inside the mounting hole. 
 

 

 

3. Secure one side of the spring onto the grip with the metal dowel 
. 

4. Use the hook tool to pull the other side of the spring into place and secure it with another 
metal dowel (Note: This step may be easier with two people). 
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15. Appendix E: Fixed Focal Length Lens 

In addition to the 10X zoom lens described in Section 8, the BioTester 6000 system can also use 
fixed focal length lenses. Other BioTester 6000 models may have a 75mm focal length lens and a 
set of lens spacers. Other focal lengths are available and are compatible with the BioTester 6000 
system.  

Install Camera Lens 

Remove the protective caps on the lens and camera body and then screw the lens into the 
appropriate series of spacer tubes.  The correct camera setup can be fine-tuned at a later step.  
The spacer tube is then screwed into the camera body.  Spacer tubes are placed between the 
lens and the camera body to change the image scale.  One 40mm spacer (largest one) is a good 
starting point for setting up the camera.  The spacers also affect the working distance of the lens 
and therefore the camera housing may need to be moved up or down on the camera mast to 
accommodate changes in the number of spacer tubes. 
 
 

 

 

 

 

 

Lens (typ. 75mm) Spacer tubes Camera (inside housing) 
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Adjusting Camera Position and Image Magnification 

 

The camera position can be adjusted using the knobs at the back and side of the camera 
housing.  If larger position adjustments are needed, the bolts that attach the camera to the mast 
can be loosened to allow rotation of the camera housing. 

Using the 75mm lens and lens spacers, it is possible to achieve a field of view ranging from 9mm 
to 30mm.  The details of the appropriate number of spacers and the required standoff are shown 
in the table below. The image magnification can be changed by adding or removing spacer tubes 
located between the camera body and the lens.  Increasing the total spacer tube length will result 
in higher magnification while reducing the tube length will result in lower magnification.  Changing 
the tube length will also change the working distance of the lens.  To adjust the vertical position of 
the lens and camera assembly, loosen the bolts that clamp the camera housing to the mast and 
raise or lower the camera housing until the image is in focus.  It is helpful to make sure the lens 
focus ring is in the middle of its rotation so that fine tuning the image focus can be done once the 
camera housing is re-clamped.   

INCREASING THE TOTAL LENGTH OF THE SPACER TUBES WILL INCREASE 
MAGNIFICATION (DECREASE FIELD OF VIEW) AND DECREASE WORKING DISTANCE 
(STAND-OFF). 

If the camera position or magnification is changed, it is important to capture a single image scale 
shot.  A glass calibration target or a ruler is acceptable for this purpose.  The scale shot will be 
useful later to characterize the size of test specimens or test specimen features. 

 
As the table and graph also show, it is also possible to swap in a lens with a different focal length 
to achieve a different range of magnifications.  This data was collected using the family of fixed 
focal length lenses available from Edmund Optics (the part numbers are shown in the table).  The 
camera has a C-mount connection, making it possible to mount a wide variety of optical 
components to best suit any application.  Currently, only the standard camera is supported. 
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NOTE: The physical camera standoff will not go below 100mm or exceed 500mm, the preceding 
table and chart provides guidelines only 

 

Spacer 

(mm)

Stand 

off 

(mm)

pix/c

m

FOV 

(mm)

Stand 

off 

(mm)

pix/c

m

FOV 

(mm)

Stand 

off 

(mm)

pix/c

m

FOV 

(mm)

Stand 

off 

(mm)

pix/c

m

FOV 

(mm)

Stand 

off 

(mm)

pix/c

m

FOV 

(mm)

0 685 78.6 162.8 1070 71 179.3 930 121 105.9

5 100 520 24.6 215 373 34.3 370 329 38.9 820 206 62.2 1540 147 86.8

10 53 935 13.7 125 682 18.8 235 560 22.9 450 404 31.7 950 258 49.6

15 90 993 12.9 185 779 16.4 350 534 24.0 675 366 34.9

20 73 1273 10.1 160 978 13.1 285 711 18.0 535 473 27.0

25 135 1186 10.8 245 859 14.9 455 578 22.1

30 125 1410 9.1 220 959 13.3 400 687 18.6

35 115 1630 7.9 200 1111 11.5 355 797 16.1

40 105 1842 6.9 185 1260 10.2 320 897 14.3

45 100 2068 6.2 170 1392 9.2 295 1003 12.8
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16. Appendix F: Protocol for Tying and 
Cutting Sutures for Biaxial Testing 

In addition to BioRakes and grips, the BioTester 6000 can optionally be equipped with bracket 
and pulley system to attach samples using sutures. 

There are many ways to attach specimens to the suture brackets using a variety of suture 
designs.  This procedure outlines one way to use double-armed sutures to accomplish specimen 
attachment. 

 

1. Assemble equipment: small vice, magnifying goggles, 2 needle nose pliers, small 

forceps. 
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2. Bend suture hooks 

 

 

  



BioTester 6000 User Manual 

97 

 

3. Tie off sutures.  First hook each bent hook around a secured post held in the vice.  Then 

tie a standard knot in the suture and use forceps to guide the location of the knot so that 

it tightens at the correct location. 
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4. Use pliers to tighten knot 
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5. Cut off excess. 
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The resulting mounted specimen should ideally look something like this: 
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